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JEFF NEUMANN

System Software Snip and Clip

YOUR GUIDE TO A SLIMMER, TRIMMER SYSTEM FOLDER

by Joseph Schorr

welve years ago, Macworld ran an
article explaining how you could
trim down your System Folder to
save memory and disk space.
“For the time being,” we lament-
ed, “making the Mac an efficient
computing tool means eliminat-
ing portions of the system that
add convenience and appeal.”

If that was true back then (when a
tully loaded System Folder weighed in at
just 200K), it’s even truer in today’s world
of 100MB operating systems that gobble
up 8 or more megs of RAM the moment
you start up. The Mac’s latest multimedia
and Internet features may be thrilling,
but they exact an increasingly steep price
in terms of memory, speed, and storage.
And while many of the new Mac models
come with 32MB of RAM and 1GB or
2GB hard drives, there are still plenty of
us trying to survive with limited disk
space and 16MB of RAM—or less.

Which brings us to a survival secret
that bears repeating: turn off—or even
throw away—the system extensions you
don’t need. And there are plenty of them.
Not only will you end up reducing clut-
ter and confusion in your System Folder,
but you'll be freeing up as much addi-
tional RAM as possible and reducing the
potential for extension conflicts.

The real trick, of course, is figuring
out which system components are ab-
solute essentials and which can be
ditched without any problem. The Apple

Token Ring NB extension, for example,
sounds dispensable, but can you safely toss
it out? (Yes, as long as you're not on a
Token Ring network.) On the other
hand, the Finder Scripting Extension
sounds like something only a program-
mer might need, but without it your
Mac’s Find File command goes berserk.

Here, then, is an updated guide to
what you can get rid of and what you
can’t live without. Go sifting through
your System Folder with this list in hand,
and you’ll find some unexpected ways to
trim system fat.

To Trash or Not to Trash

Don’t be fooled by important-sounding
names; many extensions bear titles that
make them sound essential, but they may
be totally unnecessary on your particular
system. Do you control your Mac by
voice command, using Apple’s PlainTalk
technology? If the answer is no, then get
rid of the InlineFilter extension; it’s used
only in connection with voice recogni-
tion. Ever connect your PowerBook to
your Mac using an infrared link? If not,
you don’t need the IRTalk extension,

contines
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which does nothing except handle
infrared linking. Never use Apple Re-
mote Access? Then you can get rid
of all the files in the Extensions and
Control Panels folders that start with the
word Remote, as well as Apple Remote
Access Client, Apple Remote Access

Sets and Sensibility

Personal, and the Serial Port Arbitrator.

And then there are those extensions
that system updates made obsolete but
that somehow got left behind. The Apple
Multimedia Tuner, for example, used to
be essential but was rolled into Quick-
Time 2.1. If you've got QuickTime 2.1

or later, get the Apple Multimedia Tuner
out of there for good.

But before you get too Trash-happy,
beware: some file names can be deceiv-
ing. For example, it’s obvious that you
need the Audio CD Access extension to
play audio CDs on your Mac—but did
you know that Foreign File Access is also
essential? Without it, your Mac won’t
even mount an audio CD. On the other
hand, the Graphics Accelerator extension
sounds like a vital component you should
never turn off, yet it’s useless unless your
Mac is equipped with the Apple Acceler-
ated Graphics Card—a card used exclu-
sively in the Power Mac 9500. m

Contributing editor JOSEPH SCHORR is
coauthor of Macworld Mac Secrets, fourth edition
(IDG Books Worldwide, 1997), which covers all
11,846 control panels, extensions, and enablers
found in the current Mac OS.

I'm certainly not suggesting that you trash all of the 50 or so files men-
tioned in this column; you're bound to need some of them. But once
you've determined which extensions perform which tasks, you can build
customized start-up sets using Apple’s Extensions Manager 4.0 so that

you're trying to coax every last bit of power out of an aging system. For
example, when | edit QuickTime movies, | need all the RAM and CPU
speed | can get, so | created a start-up set that temporarily eliminates
Desktop Printing, Open Transport, most of the Mac's Speech features,
and all nine extensions associated with Microsoft Office. The result: near-

only the software you need gets loaded at start-up (see Secrets, Septem-
ber 1996). This may seem like a lot of trouble, but it's worth it when

ly 1.5MB of additional free RAM.

Ms Office If you're not running any of the
Microsoft Office applications—Word, Excel, or
PowerPoint—you can safely turn off all nine
extensions that Office shamelessly stuffs into
the System Folder:

Microsoft Dialog Library
Microsoft Find File Library
Microsoft Mail Library
Microsoft OLE Automation
Microsoft OLE Library
Microsoft OLE Extension
Microsoft Tool Editor Library
Microsoft Office Manager
Visual Basic for Applications

Speech Having your Mac read dialog boxes to
you aloud in the Zarvox voice is cute, but hard-
ly essential. To disable those speech capabilities,
you turn off no less than five extensions and
control panels:

MacinTalk 2 or

MacinTalk 3
MacinTalk Pro
Speech Manager
Speech Recognition
Speech

Desktop Printing Desktop Printing adds four
extensions and a Control Strip module to your
System Folder. If you're willing to print the old-
fashioned way, you can live without all of these:

Desktop Printer Extension
Desktop Printer Spooler
Desktop Printer Menu
Desktop PrintMonitor
Printer Selector

Networking Then there's networking. If you
don't require Internet access during a work ses-
sion and don't have your Mac connected to a
network (or to a networked printer), you can
say good-bye to all 16 Open Transport exten-
sions and control panels:

AppleTalk

Open Tpt AppleTalk Library
Open Tpt ATalk 68K Library
Open Tpt Inet 68K Library
Open Tpt Internet Library
Open Transport 68K Library
Open Transport Library
OpenTptAppleTalkLib
OpenTptinternetLib
OpenTransportLib

OpenTpt Modem

OpenTpt Remote Access
OpenTpt Modem 68K
OpenTpt Remote Access 68K
OpenTpt Serial Port Arbitrator
TCP/IP

QuickDraw 3D  OK, honestly, how often do you
use QuickDraw 3D in a typical workday? You
can turn off these five files until you need them:

Apple QD3D HW Plug-In
QuickDraw 3D
QuickDraw 3D IR
QuickDraw 3D RAVE
QuickDraw 3D Viewer

CD-ROMs Operating a CD-ROM drive on a
Mac takes six different extensions. But if you
don't have a drive or don't need CD access dur-
ing a work session, you can turn them all off:

Apple CD-ROM
Apple Photo Access
Audio CD Access
Foreign File Access
High Sierra File Access
ISO 9660 File Access



JEFFREY PELO

secrets

Tips, Tricks, and Shortcuts

America Online 3.0 users, is your Favorite
Places window always hiding behind a few
dozen others? Or maybe you just hate to
open it up every session? Andy Rogers of
Bay City, Michigan, has a simple way

to make AOL navigation even more
convenient. Save a Favorite Places site by
clicking the heart in the upper-right cor-
ner of the AOL window. Next, open your
Favorite Places window (choose Favorite
Places from AODLs Go To menu), and
look for the icon of the site you just
added. Drag the icon to a Finder window,
folder icon, or disk icon on the desktop
to create a small file. If you double-click
that file, you will go to the site just as
if you had clicked it in AOLs Favorite
Places window.

With a bunch of these files you can
add a list of favorite places to your Apple
menu, where it’s always available. Make
sure the Submenus option is turned on in
the Apple Menu Options control panel,
and create a folder named AOL Favorite
Places in your Apple Menu Items folder.
Put all your favorite-places files or aliases
of them in that folder. You can create sub-
categories of favorite places by creating
folders within your AOL Favorite Places
folder; place each favorite-place file or its
alias in the appropriate subfolder. Instant-
ly you have a hierarchical list of favorite
places available all the time.

Spotting Empty Folders

When I organize stuff in the Find-

. er, I distribute items among folders
named by category (letters of the alpha-
bet, for instance). Later, when I’m archiv-

ing those folders, I'd like to know which

by Lon Poole
ones remained empty, but I don’t want to
open each folder individually. Is there an
extension that makes empty folders a par-
ticular color or in some other way indi-
cates empty folders? Alternatively, is there
asingle command that opens all folders in
a window at once (in, say, Name view)?
Micunacer CoONEY

Friendship, Maine

A You can use keyboard commands to
. see the contents of multiple folders
in a window that’s set to an outline view,
such as by name. Select the folders (press

Quick Tips

folder sizes slows the Finder, especially if
you keep windows open from file servers
or shared folders.

Free MPEG

How can I view an MPEG movie on

- my Performa 6200? I would like to

do this with a free software solution as
opposed to an expensive video card.

PETER WHEDBEE

Baltimore, Maryland

Apple’s free QuickTime

.MPEG extension en-
ables software-only playback
of full-screen MPEG-1 and
VideoCD files on Power
Macs with QuickTime 2.5 in-
stalled. You can view MPEG
movies with the included
MoviePlayer application or
another QuickTime-enabled
application. You can also view
MPEG movies in a Web
browser with version 1.1 or
later of Apple’s QuickTime
plug-in. All this software
is available from Macworld
Online (bttp://www.macworld
.com) and America Online
(keyword Macworld).

&-A to select all) and press 3-right arrow
to expand the selected folders and see
their contents. To also expand all folders
contained in the selected folders, press
$-option-right arrow. Pressing &-left
arrow collapses all selected folders, and
pressing #8-option—left arrow collapses all
selected folders and all folders in them.
You can also force empty folders to
the bottom of a window. Just turn on the
Calculate Folder Sizes option in the
Views control panel and view the window
by size. Keep in mind that calculating

Easy Booklets

Do you know of any shareware util-
. ity that converts a word processing
document (ClarisWorks or Corel Word-
Perfect) to a staple-in-the-middle booklet
form? I am trying to print a script for a
local production, and the usual letter-size
page would be rather unwieldy on stage.
SHANE LIESEGANG
Jacksonville, Florida

continues
131
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QUICK TIPS

Laseritiriter 8 Page Setup Lo

scole: [T00]%

Personal Defaults If the topmost pop-up menu for
LaserWriter 8.4.X's Page Setup lists the current appli-
cation, you can save the current Page Setup settings
as the default settings for that application by option-
clicking the OK button. If the pop-up doesn't list an
application name, you can save the current settings

as generic defaults by option-clicking OK.

A Use ClickBook from the ForeFront
. Group ($49.95; 713/961-1101, http://
www.clickbook.con). After turning on
ClickBook with the Page Setup command
(or globally with the ClickBook control
panel), you simply print as you usually
would. ClickBook intercepts the page
images on their way to the ink-jet or laser
printer and reformats them to the layout
of your choice. The product includes lay-
outs for several types of folded booklets
and cut-sheet booklets on letter or legal-
size paper, double-sided pages in portrait
or landscape orientation, address books,
thumbnails, and trifold brochures, or
make your own layouts. You can preview
your document in any layout before print-
ing, and you can combine multiple docu-
ments from the same application or dif-
ferent applications into one booklet. The
company also sells a long-reach stapler for
binding your folded booklets.

LaserWriter Page Setup Defaults

The LaserWriter 8.4.1 driver’s

. default paper size is US Letter

Small. I want the driver to default to US

Letter instead, but I can’t make the driv-
er remember my change.

Izzy VASQUEZ

Albany, California

A After making your changes to the
. Page Setup settings for LaserWrit-
er 8.4.X, press the option key while click-
ing OK. An alert asks you to confirm
whether you want to save the current
Page Setup settings as the default. You
have to perform this exercise separately in
each application that has its own Page
Setup settings. To see if a particular appli-
132
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cation has its own Page Setup settings,
look for the application’s name in the pop-
up menu at the top left of the Page Setup
dialog box (see “Personal Defaults”). If
that pop-up menu doesn’t list the current
application’s name, the application uses
the generic Page Setup default settings.
Changing the generic Page Setup defaults
in one application affects all applications
that use them (but doesn’t affect applica-
dons with their own Page Setup settings).

Rename Open Word Files
Macworld’s review of Nisus

TIP Writer 5.0.1 (Reviews, April
1997) asks, “What other program lets you
rename an open document without clos-
ing it . . . ?” Actually, you can easily
rename an open document in Microsoft
Word 6. Simply find the document’s icon
in the Finder, select its name, and make
your changes. When you return to Word
6, the document has its new name dis-
played in the title bar.

STEPHEN TANNENBAUM

Thornbill, Ontario, Canada

Audio CD Autoplay

TIP I like to play audio CDs on my
Mac. Putting an alias of Track 1
from any audio CD into the Startup Items
folder has the Finder automatically
launch AppleCD Audio Player during
start-up and begin playing whatever CD
is in the drive. The Track 1 alias works
with any audio CD, not just the one used
to make the alias. If there’s no CD in the
drive, the Mac requests one.
ScorT WOOLEDGE
Brooklyn, New York

If you have QuickTime 2.5, you can have the
Mac automatically play an audio CD not only
during start-up but any time you insert one.
Turn on the Enable Audio CD AutoPlay option
in the AutoPlay section of the QuickTime Set-
tings control panel. This feature starts playing
the CD earlier during start-up than the Start-
up Items method and doesn’t require the Apple-
CD Audio Player application. You have to open
that application or its equivalent if you want to
control playback of an autoplaying CD while it’s
playing. For an alternative to the AppleCD
Audio Player, see “Audio-CD Control.”

To bear an audio CD on some Macs, par-
ticularly when playing from an external CD

drive, you must click the Options button in the
Sound In section of the Sound control panel, then
select an input source and turn on the Play-
through option. Your Mac may handle Play-
through automatically; you'll have to experiment
to see. On Macs that normally use the Monitors
& Sound control panel, such as Macs with PCI
slots, the Sound control panel is in the Apple
Extras folder, not the Control Panels folder. You
cannot set the Playthrough option with the Mon-
itors & Sound control panel.

To hear audio from an external CD player
through the Mac’s low-fi internal speaker or
through external powered speakers connected to
the Mac’s sound-out port, you must run a stereo
patch cord from the external CD drive’s sound-
out jacks to the Mac’s sound-in port (or to the
audio-input jacks if your Mac bas them). With
some Mac models and versions of the Mac OS
you must also move the External CD Sound file
Sfrom the Apple Extras folder to the Extensions
folder. The only Macs that Apple bas said require
that extension are the 630 series and the Power
Mac and Performa 5200 and 6200 series. If
your Apple Extras folder doesn’t contain the
External CD Sound extension, you probably
don’t need it. Apple doesn’t distribute the exten-
sion through its online software updates library
or on system software CDs.—L.P.

PopupCD

D Auto-play
[ Auto-eject
[ Autoresume

> POBUDCD KEYROARD CONTROL KEYS hd

il £
o] by s

. Select function & press desired ey combination M

(Detaus ) =3 N

Activate baiioon help
for more information

Audio-CD Control Want to control audio-CD play-
back with keystrokes or a pop-up remote control
from any application? Paul Birdsong of Herman,
Nebraska, recommends the $15 PopupCD shareware
by John Brochu. It can also record audio clips direct-
ly from CD to hard drive. Shown here: the PopupCD
control panel with its keystroke-configuration dialog
box, and the pop-up remote control.



Pick Out TrueType Fonts

TIP A(l(.)l)e' .Type Manager 4.0’
antialiasing feature may seem
purely cosmetic, but if you're in the pre-
press industry it can perform a valuable
function. Because ATM 4.0 does not
antialias TrueType fonts, they become
incredibly easy to spot within open docu-
ments. If you need to avoid sending True-
Type fonts to your output device, this
unintended (in my opinion) feature

proves quite useful.
Curis WOODFIELD

Baltimore, Maryland

PageMaker Zoom Toggle
TIP In Macworld’s April Publishing
Whorkshop, Olav Martin Kvern
wrote a fine article on tps and tricks with
Adobe PageMaker 6.0 and 6.5—the sort
of stuff that makes your publication
invaluable to normal schmoes such as
myself. The article explains how to
change the accursed -0 (zero, for Fit
In Window) to 38-W with ResEdit, but
doesn’t mention the zoom toggle. It gives
you quick access to the three zoom levels
you need most—Fit In Window, 100 per-

cent, and 200 percent.

In Fit In Window view, #-option-
click with any tool, and boom, 100 per-
cent! Do itagain to go back to Fit In Win-
dow view. Include the shift key to toggle
between 100 percent and 200 percent.

AARON VEGH

Hamilton, Ontario, Canada

Mounting Novell NetWare Volumes

TIP I use my Macintosh on a Novell
NetWare 4.1 network. Because
of Novell’s security implementation with
NetWare 4.X, you can no longer specify
that NetWare volumes automatically
mount at start-up. It is time-consuming to
log in to Novell Directory Services and
use the Chooser to mount volumes on
multiple servers. To save time, I put alias-
es of all the NetWare volumes in my
Startup Items folder. After I authenticate
a connection to the first volume (by sim-
ply tvping in my user name and pass-
word), all the other volumes are mounted
even if they're on different servers.
SerH T. HiLL
Columbus, Ohio

Bugs and Turkeys

[ ]
Brian Landwehr of West Des

Moines, lowa, found that Adobe

Photoshop 4.0 won't allow users
to scale layers or sections properly using the
Free Transform function. The results: pixe-
lated, jagged-edged images. To avoid this
problem temporarily, Adobe Systems (415/
961-4400, http://www.adobe.com) recom-
mends using the Image Size command to
drag the desired layer to a new document,
reduce the size, then drag it back to the
original document. The company is current-
ly working on a Free Transform fix and will
post it on its Web site.—ALLYSON BATES
Macworld will send you a Bug Report or Turkey
Shoot T-shirt if you are the first to inform us of a
turkey or a serious, reproducible bug that we report

in this column. See How to Contact Macworld.

Improved Browser Script
TIP Your AppleScript application
that mounts a ShrinkWrap RAM
disk containing a Web browser’s cache
just before opening the browser is a great
idea (Quick Tips, April 1997). A problem
occurs, however, if you quit the browser
but forget to put away the RAM disk, and
later you double-click the AppleScript
application to use the browser again. If
the RAM disk is already mounted when
the script runs, an error message states
that the file is already open, and the brows-
er does not open. There are workarounds,
but you don’t want to confuse novices.
Adding an “if” statement to the script
solves the problem:
tell application "Finder"
if not (exists disk "Browser Cache") then
tell application “ShrinkWrap™"
activate
set RAM Disk of preferences to true
mount alias “Macintosh HD:Browser
Cache image" with unlocked
quit
end tell
end if
end tell
activate application "Netscape Navigator™ 3.0"
In this script, replace "Browser Cache®
with the actual name of your RAM disk,
and replace "Macintosh HD:Browser Cache

image" with the path to your ShrinkWrap

disk image file. Also, put the exact name

of your browser in the last statement.
THoMas L. AINscoUGH

North Dartmouth, Massachusetts

The script requires Aladdin Systems’ Shrink-
Wrap 2.0 or later. Earlier versions do not allow
setting ShrinkWrap preferences with Apple-
Script commands.—L.P.

Quick Bits

e When using a crossover cable to con-
nect two Macs equipped with 10BaseT
(RJ-45) Ethernet jacks without a hub (as
described in April’s Quick Tips), you must
start up both computers before changing
the connection to Ethernet in the Apple-
Talk control panel. After you've success-
fully set the AppleTalk connection to
Ethernet, a similar error occurs if you
subsequently start up one computer while
the other is off. An alert explains, “An
error occurred while trying to start up
your AppleTalk connection. The built-in
LocalTalk port will be used instead.” If
that happens, you have to reset the Apple-
Talk connection to Ethernet after starting
up the other computer.

» Following are updates to the list of
DOS and Windows file-name extensions
in April Quick Tips, from Jim Ambrose of
Ripon, California; Stephen K. Suh of
Ottawa, Ontario, Canada; and original
contributor John Impallomeni of Albu-
querque, New Mexico:

.Al is for Adobe Illustrator 4.1

.P65 is for Adobe PageMaker 6.5
publication files

.T65 is for Adobe PageMaker 6.5
template files

.qxd is for QuarkXPress documents m

LON POOLE answers readers’ questions and
selects reader-submitted tips for this monthly
column. His latest book is Macworld Mac OS 7.6
Bible, fourth edition (IDG Books Worldwide, 1997).

Shareware mentioned in Quick Tips is available from
Macworld Online (bttp://www. macorld.com) or
America Online (keyword Macworld).

We pay from $25 to $100 for tips on how to
use Macs, peripherals, or software. Send questions
or tps to quicktips@maczorld.com or Macworld Quick
Tips, 501 Second St., San Francisco, CA 94107. All
published submissions become the sole property of
Maczorld. Due to the high volume of mail received,
we can’t provide personal responses.
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A FLIGHT of FANCY.

Actions boost your
productivity by letting
you automate critical
imaging tasks and
then apply them to a
folder full of images.

With support for all the
key Web file formats,
it's no wonder that
Adobe Photoshop is the
number one tool for

Web image processing.

Grids and Guides
bring precision layout
capabilities to even
the most complex

compositing projects.

Free Transform allows
virtually unlimited
experimentation while

retaining image quality.

Adjustment Layers
give you unlimited
flexibility for color

and tonal corrections.

Adobe, Adobe Photoshop and the tagline, “If you can dream it, you can do it" are trademarks of Adobe Systems Incorporated. Macintosh is a registered trademark of Apple Computer, Inc, Windows
is a registered trademark of Microsoft in the U.S. and other countries. All other marks are the property of their respective companies, ©1997 Adobe Systems Incorporated. All rights reserved,

Circle 253 on reader service card

ADOBE’

PHOTOSHOP 4.0

Let your imagination soar.
Because the newest version
of Adobe Photoshop has the
wings to take you anywhere.
Now, the world’s leading
photo design and production
tool has evolved. Version
4.0 adds a
host of new

capabilities

to send your Adobe Photoshop 4.0

productivity

CALL NOW FOR YOUR

UPGRADE

TO THE NEW ADOBE

and creativity

PuHotosuor 4.0

skyward. So
FOR MacinTOSH®

anp Winpows?®

whether you
are designing compelling
visuals for print, laying out
a sexy interactive interface
for your latest multimedia
creation, or processing scores
of images to fuel your Web
page, Photoshop 4.0 is the
indispensable tool that’s ready
to lift your visions to new
heights. Call 1-800-492-3623,
offer code 26104 or visit our

web site at www.adobe.com.

®

A

Adobe

If you can dream it,

you can do it!



JERRNITER JE33LE

by Jim Heid

e’'d all like to wear hand-
tailored originals, but
most of us have to buy off
the rack. A similar reality
exists with media. We'd all
like to commission origi-
nal graphics and music for
our presentations, Web
sites, videos, or CD-ROM
titles, but the budget doesn’t always allow
it. (The schedule often has a say, too.)

The good news is that a veritable
department store of canned media ele-
ments is available. Photographs, back-
grounds, buttons, music—you could
almost put together a project using noth-
ing but clip media. But if you are a smart
dresser you’ll want to alter your clip
media before you wear it. By editing
images and tweaking buttons and back-
grounds you can take the “clip” out of
clip art (and you don’t have to stop there;
you can alter audio too).

This month, I shine the spotlight on
some particularly impressive collections
of visual media—photography, anima-
tions, background textures, and user-
interface elements—and show several
ways you might tailor them. Next month,
I'll cover stock music and sound effects.
For samples and more information, visit
btp:/fwww.beidsite.com.

Pictures Perfect
Tens of thousands of photographs are
available from companies such as Photo-

Working with Clip Media

CHOOSING, USING, AND CUSTOMIZING OFF-THE-RACK MEDIA

Disc (206/441-9355, bttp://www.photodisc
.comt) and Adobe’s Image Club Graph-
ics division (403/262-8008, http://www
dmageclub.com).

Each offers dozens of CD-ROMs
containing images organized into cate-
gories: objects, people, nature, medical
themes (ouch). PhotoDisc’s CD-ROMs
range in price from $149 to $299; Image
Club Graphics’ go for $79.99 to $249.99.
PhotoDisc also sells individual images
through its exquisite Web site ($29.95 to
$49.95). Enter keywords (for example,

sunset and beach) and the Web site shows
thumbnail views. One click puts an image
in your virtual shopping basket.

Apply Paint or Pen Effects Numer-
ous Adobe Photoshop filter collections
enable you to make a photograph look
like a charcoal drawing, a pen-and-ink
sketch, a Picasso—you name it. Adobe’s
three-volume Gallery Effects series
(included with Photoshop 4.0; 415/961-
4400, bttp://www.adobe.com) sports numer-
ous paint and pen effects. Xaos Tools’
continues
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Paint Alchemy ($199; 415/538-7000,
http:/fwww.xaostools.com) is also a superb
tool for adding paint-type effects (see
“Top 20 Photoshop Plug-Ins,” Macworid,
September 1996).

Add Arty Edge Effects Auto F/X’s
three-volume Photo/Graphic Edges
series ($179 each; 603/569-8800, http://
www.antofx.com) does a beautiful job
of adding creative effects such as film
sprockets, paint stipples, and geometric
patterns to the edges of images. You can
also create your own custom edges in
Photoshop 4.0’ Quick Mask mode (see
“Adding an Arty Edge”).

A Cast of Characters

Sometimes you don’t need a photograph
but a line illustration—a little piece of
spot art—to enliven a screen. One option
is a pictorial font. Letraset (201/845-
6100, http://www.letraset.com), Interna-
tional Typeface Corporation (212/949-
8072, bttp://www.esselte.com/itc/), and
Image Club Graphics are three sources
for pictorial fonts that contain dozens of
illustrations apiece. Numerous shareware
pictorial fonts are also available; you can

download some from my Web site.
Because pictorial fonts are outline fonts,
it’s easy to get the right-size illustration:
just choose the point size you need.
Create 3-D Art Many programs can
render 3-D text; examples include Stra-
ta’s Strata StudioPro and StrataType 3d
(801/628-5218, http://www.strata3d.com),
MetaTools’ Infini-D (formerly from Spec-
ular; 805/566-6220, http://www.metatools
.com), and Xaos Tools’ TypeCaster Photo-
shop plug-in. Use them to wurn a font
dingbat into a glittering, multidimen-
sional character or even an animation.

Art in Motion

It’s a rare Web site that doesn’t have an
animated GIF image on it somewhere.
Recognizing this, PhotoDisc has intro-
duced its Animation Series collection,
which currently consists of two CD-
ROMs. In the Standard version (5149
each), each animation is provided in
three sizes and in both GIF and Macro-
media Shockwave formats. In the Pro
version ($249 each), the original Macro-
media Director project files are also
included, and the frames are provided in

both 8- and 24-bit color depths. Letra-
set’s $159.95 Web.Stdr Art Kit Portfolio
Collection, a set of user-interface ele-
ments and  backgrounds, also includes
some animated GIFs.

A vast selection of free animated
GIFs is also available on the Web. Many
of them are worth what they cost, but
there are some clever collections, too.

Rather than using someone’s anima-
tion as is, consider making some tweaks.
A great tool for modifying animated
GIFs is Totally Hip Software’s Web-
Painter ($99.95; 604/685-6525, bttp://
www.totallybip.com). Unlike the legendary
(and free) GifBuilder (bttp:/iawww.epfl
.ch/Staff/Yves. Piguet/clip2gif-home/
GifBuilder.btml), WebPainter provides a
full array of painting tools. To modify the
original Macromedia Director projects
included with PhotoDisc’s Pro series,
you'll need Director.

Change the Timing You might pre-
fer that an animation play back faster or
slower than its original pace. You can
make timing adjustunents in any GIF ani-
mator—just specify a new duration for
the frame or frames you want to change.

From Good Stock

Applying the Trace Contour
filter to one channel of this
image (PhotoDisc Back-
grounds and Textures Vol-
ume 3) changed the look
of the bubbles. The artist
also gave the background a
new color, adjusted Bright-
ness/contrast, and applied
Gaussian Blur.

this button (from E ik
Artbeats’ WebTools) *
appealed to the artist. She w
cropped out the button's

edges, then rotated, scaled,
and distorted the guitar.

The guitar image on
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The elements may be canned, but the result is highly personal. Macworld senior

design associate Belinda Chlouber used Adobe Photoshop to customize a variety

of clip media and combine them into a screen for a hip, hypothetical music project.

This project called for notes,
and the artist found some on
a button (from WebTools).
She added highlights and
cropped the button edges,

then scaled, rotat-
| ed, and distorted
the notes.

This button (from
WebTools) needed
very little change.
The artist adjusted its color,
then scaled the button to fit
the radio image (from Photo-
Disc's Object Series).

As users interact with a live
_ project, different button
. versions pro-
*""&Q Q“ vide feedback.
(’ Q_, This button set
(from WebTools) offers sev-
eral variations.



Change the Soundtracks Photo-
Disc’s Shockwave animations have sound
effects—in one, an animated clock radio
plays tunes as you interact with it. You
might change those sound effects to your
OWN tunes or voice.

Add Your Own Characters Use an
animation as a starting point, not an end
result. Another PhotoDisc animation
shows a hand pushing down. Try putting
text or an image under the hand and dis-
torting it so that it becomes crushed.

Interface Lifts

The common denominator in any inter-
active producton is the window dressing:
screen backgrounds, borders, navigation
buttons, and other user-interface ele-
ments. Several CD-ROM collections
offer an assortment of Web interface
essentials, and each has unique assets.

Image Club’s $99 WebMorsels in-
cludes numerous styles of common navi-
gation buttons (Whats New, About,
Products, Home). Artbeats’ (541/863-
4429, bttp:/fwww.artbeats.conr) $69 Web-
Tools includes buttons in a variety of
states (such as up and down) as well as a
collection of sound effects. Aridi Com-
puter Graphics’ (972/404-9171, htip://
www.aridi.com) $79 WebClips supple-
ments its user-interface elements with a
set of attractive ornaments. The compa-
ny also sells CD-ROM collections con-
taining meticulously drawn background
patterns, ornaments, and initial capitals.

Mainstay’s (805/484-9400, http://www
.mstay.com) $139.95 PageCharmer, which
should be shipping by the time you read
this, lets you build Java applet-based
Web user interfaces containing animated
multistate buttons.

For CD-ROM, kiosk, or presenta-
tion work, there are interface element
collections for Director that include
canned Lingo scripts. statmedia’s (714/
280-0038, bttp://www. statmedia.com)
$180 Instant Buttons & Controls 3.0 is
the best of the bunch and the easiest to
use: just drag and drop its animated,
sound-effects—enhanced buttons into
vour Director project. Vicious Fishes
Software’s (714/280-0038, http://www
viciousfishes.com)  $49.95  Multimedia
Tackle Box is another excellent collection
of interface elements.

Change the Images You like a but-
ton or texture, but it clashes with your
project’s color scheme. Use Photoshop’s
color-correction features to change the

1. Activate Photoshop's
Quick Mask made by
clicking on the tcol pal-
ette's Quick Mask icon.

Select an area within the
image; for the best re-
sults, leave a generous
amount of image outside
the selection.

pms v

Use the Edit menu's Fill
command to fill the selec-
tion with black.

After you've filled the
selection, it appears as a

5.

mask; red areas of the
image are protected from
alteration. Choose None
from the Select menu.

Choose Gaussian Blur
from the Filter menu's
Blur submenu, and speci-
fy a radius of between 10
and 20 pixels.

SO Sniwed Strokes ‘FETE|

]

Options

stroke Length -
Spray Redius !E

Choose a brushstroke
effect from the Filter
menu's Brush Strokes
menu. Sprayed Strokes
works well. Fine-tune the
filter's options to get an
edge you like. (To see the
edges, drag the image
within the preview area.)
To apply the filter, click
on OK or press return.

. Exit the Quick Mask

mode by clicking on the
Standard Mode icon.

Ad d i ng an Arty Ed ge Adobe Photoshop 4.0's Quick Mask

mode and bundled effects make it easy to create attractive edge effects.

After you exit Quick
Mask mode, choose In-
verse from the Layers
menu to select the un-
protected (and now fil-
tered) area of the image.
Delete the selection by
pressing the delete key.

Now you see the selec-
tion you made with its
artistic edge effect.

hue. Other alteration possibilities include
resizing, inverting, and filtering.

Make Your Own TTextures and
backgrounds are easy to make. Try scan-
ning a piece of linen or burlap, or a sheet
of handmade paper that has an interest-
ing grain pattern. Then tweak and modi-
fy it in Photoshop. Or use Three D
Graphics’ (310/553-3313, bttp://www
threedgrapbics.com) $129.99 Texture Cre-
ator, a Power Mac-only 3-D rendering
package that specializes in making tex-
tures and backgrounds. Formerly Adobe
TextureMaker, Texture Creator 2.0 lets
you test how a texture will tile in a Web
browser. Another terrific tool for making
textures and backgrounds is Xaos Tools’

$199 Terrazzo 2. This Photoshop plug-in
lets you create textures from scratch or
base them on an existing image.

High-class clip media has a benefit
that goes beyond the budget and sched-
ule: browsing beautiful collections of
photos and user-interface elements can
fire up your creative juices. At least they
have that effect on me. But then, I've
been known to keep the photos that
come with new wallets. m

Next month: Using stock audio
Contributing editor JIM HEID's latest book is
HTML & Web Publishing Secrets (IDG Books

Worldwide, 1997).
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If you publish anything—a
magazine, a Web page, even a
newsletter—the chances are

good that you use Adobe
Photoshop. This program is
so incredibly complex and rich
that many people spend all
day, every day, sitting hypno-
tized before their screens,
trying to find the best way to
do their work. Wouldr’t it
be great to eliminate the
glassy-eyed stare and get
just a little more efficient,
especially now that you’re
using Photoshop 4?

Help is here: read on for
a few of my favorite tech-
niques. These tricks help me

Prblisting Workshop

(et the Most from Photoshop 4

by David
get my work done faster and
with much less stress.

Relearning Photoshop

If you’ve updated recently to
Photoshop 4, you've probably
been frustrated by the subtle
changes in its interface. Your
period of adjustment to
Photoshop’s new look-and-
feel will seem a lot shorter if
you arm yourself with a few
basic tools and shortcuts.

One of the hardest things
to get used to is the way
Photoshop 4 makes a new
layer every time you create
type or paste an image. It
never seems to wind up where
you want it, and you must use
the move tool to reposition it.
At first it’s frustrating, but

Blatner

don’t get mad; just hold down
the & key. That gives you the
move tool temporarily so you
can move the whole layer to
where you need it.

Then, if you don’t want
your type or pasted image on
a separate layer, you can press
#-E to drop it down onto the
layer below (a new shortcut in
version 4). You’ll find & and
#-E to be your friends in this
new version.

Here’s another type prob-
lem: I always forget to pick the
color T want my text to be
before I actually create it, so
the text comes in the wrong
color. Instead of selecting
Undo, T just pick a new color
and press option-shift-delete.
That shortcut fills a layer with

the foreground color as
though the Preserve Trans-
parency feature were turned
on—it won't fill any transpar-
ent pixels. My text gets a new
color, and the rest of the layer
stays transparent.

Context-Sensitive
Controls

Another of my favorite Photo-
shop 4 tricks is to hold down
the control key (not the 3 key)
when clicking; up pops a con-
text-sensitive menu. Which
menu you get depends on
what tool you have selected
and where your cursor is when
you click. If you've got a paint-
ing tool selected, you get a list
of paint modes; control-click-
ing with a selection tool gives

Snapping to Guides

ReTiocions ® 109%

Photoshop 4 lets you drag guides out of the rulers onto

your document, for pladng elements precisely (38-R turns

the rulers on or off). You can snap elements to those
guides by dragging the edge of an element within a few
pixels of a guide. You czn snap the center of the element

to a guide by dragging its centerpoint near the guide.

you place a particular pixel at a particular point. When
you option-drag a rectangular or oval selection marquee,
the pixel you start on becomes the exact center of the

selection. Now placing that pixel is a snap. S TEnE

Snap a Selection When you move a
selection (left), Photoshop surrounds it
with an invisible box (represented here
in red). When you release the mouse,
Photoshop reduces your selection to

A Great Trick Photoshop's snap-to-guides feature lets

the pixels on the layer (right). Here, the
bounding box's left edge is snapping to
the vertical guide and the center is
snapping to the horizontal guide.

Snap a Layer If you move a layer
around without making a selection, the
bounding box encompasses everything
on the layer. Here, the left and top
edges of the layer's bounding box are
snapping to the guides.
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you a list of selection and layer
features; and if you have the
move tool selected, you see a
menu of whatever layers
you’re currently over (if you
don’t have the move tool
selected, you can get this
menu by &-control-clicking).
Select one of the layers to
switch to that layer.

New File, Same Size

Need a second document the
same size as the first? Don’t
waste your time writing down
pixel dimensions. Photoshop’s
Window menu remains avail-
able (it doesn’t gray out) when
you’ve got the New, Canvas
Size, or Image Size dialog
boxes open, and you can copy
file settings (pixel dimensions,
resolution, and so on) from
any other file listed at the bot-
tom of the Window menu.

Rebuild Type List
If you use a font-management
utility such as Alsoft’s Master-
Juggler, Symantec’s Suitcase,
or Adobe’s ATM Deluxe,
you’ve probably noticed that
Photoshop doesn’t automati-
cally update its list of fonts
when you add or remove a
font with the utility. You might
assume that you have to quit
and relaunch Photoshop. For-
tunately, there’s a better way.
In Photoshop 4, shift-
clicking with the type tool
forces the program to update
its font list. In previous ver-
sions of the software, you have
to hold down the option key
and click the mouse button
(with the type tool selected) at
exactly the same time (if you
click just a little too late, the
option key gives you the eye-
dropper; if you click too soon,
Photoshop just brings up the
Type dialog box without reset-
ting the font list).

Importing EPS Files

How can I get my Adobe
PageMaker and QuarkXPress
files into Photoshop? That’s
one of the questions I get

asked most often in my semi-
nars. In the past, you had to
go through all kinds of machi-
nations when you wanted to
import anything other than an
Adobe Illustrator EPS file;
Photoshop 4 lets you open any
EPS file and rasterize it (turn
it into a bitmapped image).
Surprisingly, Adobe has hard-
ly advertised this incredibly
great feature at all. Just select
Open from the File menu and
select the EPS graphic.

Replay Last Settings
Want to make the same
Curves adjustment to a num-
ber of different images? Hold
down the option key when you
select Curves, and the dialog
box automatically resets to the
way it was when you last
applied the effect. This also
works for Levels, Hue/Satu-
ration, and most of the other
features in the Adjustment
submenu in the Image menu.
Even better, just add the
option key to the feature’s key-
board shortcut (§8-option-M
for Curves instead of §-M,
and so on).

Learn a Trick, Get a
Bonus

If you work by the hour, you
probably don’t mind sitting in
front of the computer screen,
slowly falling into a pixel
trance. But if you've got to get
your work done quickly,
you’ve got to learn all the
tricks you can. There are
many hidden treasures buried
deep within Photoshop—such
as holding down the & key
when selecting About Photo-
shop from the Apple menu (in
4.0, then #-click on the nose
vou’ll see). Taking the time to
learn them now will pay off
later with increased efficien-
cy—who knows, maybe even
araise. m

DAVID BLATNER is coauthor of
Real World Photoshop 4 (Peachpit Press,
1997). You can write to him at devid@

n100.com.

Adjustment Layers Help You Select Edges

Photoshop 4's New Adjustment Layer feature is great for tonal
and color correction, but it can help you make selections, too.
If you're having a hard time getting a good high-contrast edge
with which to make a selection, add an adjustment layer
(either Curves or Levels works well) and give the layer an
extreme setting to bring out the edge as best you can. After
you make your selection, throw the adjustment layer away. Your
original image isn't harmed at all, and you save a lot of time.
(Thanks to digital artist Greg Vander Houwen for this one.)

1 This image contains edges

that are very difficult to dis-
cern (notice the dark edges of
the petals), making it nearly
impossible to select just the
rose cleanly and quickly.

3 Photoshop displays the
settings dialog box for the
adjustment layer you've cho-
sen. An extreme adjustment
to the green channel brings

. out the edges in this image.

5 To edit the selected pixels,
create a new adjustment layer
(the selection automatically
becomes a layer mask). Now
throw away the Curves ad-
justment layer (it was useful
only for making the selection).

2 Add a new adjustment
layer (s8-click on the New
Layer button or select New
Adjustment Layer from the
pop-out menu). To enhance
edges, | like to adjust Curves.

4 Once you have an adjust-
ment that makes the edges
clear, you can use Photo-
shop’s selection tools more
easily. | was able to select the
rose in just a few steps.

6 Only the unmasked parts
of the image (here, the rose)
are affected by my new Hue/
Saturation settings. When
you like the changes, flatten
the image's remaining layers,
and prepare it for print.
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Painting through a Line-Art Mask in Photoshop

ARTIST John Ritter produces digital and
traditional illustration in his Aptos, Cali-
fornia, studio for a variety of clients,

including Time Warner, IBM, Adobe
Systems, Mercury Records, and Dow
Jones. He has lectured on illustration and
design at American Institute of Graphic
Arts in Charlotte, North Carolina.

HOW IT WAS DONE Ritter uses this
painting technique to add dimension and
painterly effects to line art—both clip art
and his own pen-and-ink drawings. Using
the line art as a mask, he paints through it
and adds textures to the background
image while maintaining the outline of
the line art. He originally used this
process with type, painting through the
character forms; later he realized it would
work just as nicely with images.

For this illustration, Ritter began by
scanning a photograph he’d taken of the
wall of an old warehouse in San Francis-
co, making it the background image. The
line art came from a compilation of roy-
alty-free historical illustrations and
designs. The texture was a canvas he’d
covered with layer after layer of paint and
then scanned into Photoshop.

After painting through the mask,
adding a drop shadow to the line art, and
blending in the canvas texture, Ritter
boosted the contrast to make the image
more vibrant.

TOOLS Hardware: Power Macintosh
8500/120 with 150MB of RAM and a
2GB internal hard drive; two FWB 4GB
external hard drives; a Radius 17-inch
Precision Color Display; an Agfa Arcus II
Scanner; and a Wacom ArtZ Graphics
Tablet. software: Adobe Photoshop 3.0. m
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by

Cathy

Abes

0 The artist scanned
a photograph that he'd
taken of a warehouse
wall in San Francisco to
use as the background
for the illustration.

9 Ritter then scanned

an old etching (from
The Clip Art Book, Stu-
dio Edition, by Gerard
Quinn; Crescent Books,
1994), pasted the scan
into a new alpha chan-
nel in the wall image
(channel 5), and invert-
ed it. Next, he loaded
that channel.

e Creating a custom
200-pixel brush at 50
percent opacity, Ritter
began painting through
the line-art mask, vary-
ing the opacity between
50 and 80 percent and
using several shades of
green and orange.

O To add a drop
shadow, he feathered
the selection with a 20-
pixel radius and offset
the selection, using 2t-
option-shift to drag it
down and to the left
while constraining it. He
saved the selection to a
new alpha channel (6).
While viewing just chan-
nel 6, he loaded channel
5 and filled it with 100
percent black to protect
the painted areas.




9 Back in the main
image, Ritter loaded the
feathered version of the
scan (channel 6); in
the Brightness/Contrast
controls he reduced the
brightness to -41 to
darken only the shad-
ows around the line art.

@ To add more tex-
ture to the image, he
then scanned in a piece
of canvas on which he'd
built up numerous layers
of paint.

e After loading chan-
nel 5, Ritter pasted the
painted canvas texture
into that channel as a
floating selection. Ini-
tially the texture came in
at full opacity and ob-
literated the painting
underneath.

@ Using controls in
the Layers palette, Ritter
tried compositing the
floating selection with
the background layer in
Multiply mode at vari-
ous opacities, finally set-
tling on 80 percent to
allow the painted areas
to show through with
only the darker parts of
the texture still visible.
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Keynotes

Mactivity is proud to
host the most
prominent figures in
the computer industry

Read Macworld‘?

Technoloc
Theatre

Attend our Technology
Theater Free Lecture

You should be at
Mactivity’

The Macintosh Professionals Conference.

presenting their views Series.
on Apple, the Internet
and their visions for

your computing world

of tomorrow.

- Apple’s New OS!
* Wireless Internet Acce
+The latest Claris Prodt

*The Best Mac/Interne
Solutions!

........ and more sessions
being scheduled!

Daily
Giveaway

Over $10,000 i
prizes to be
given away!

Marc
Andreesen

Netscape
Communications
Corporation

Wednesday,
June 18th
1:00 - 1:45

Win cool software like
Adobe PhotoShop,
PageMill and Acrobat
well as dozens of othe
Macintosh titles! Interr
software, Web site crez
tools, productivity
applications and more
be given away daily!

See all the Coolest
Products—For FREE!

Product
Showcase

June 18-20 10:00-4:00pm

Now in its 7th year, the Mactivity Product
Showcase, is the perfect place for Macintosh
professionals to find the solutions that they

Webmasters
Vendor Fair

June 15 5:00-9:00pm

Mactivity's Webmasters Vendor Fair has
over 50 companies all showing off the
hottest innovations in Web servers, CGls,

Hands-on
Classroon

Don Crabb

MacWEEK plug-ins, content creation tools, scripting need to connect LANs to the Internet, create (space limited

Th d tools, da.tabases, commerce solutilons‘ ané Intgrnet servers, solve Macintosh OS problems, W \ve have an exciting
ursaay, more, this one evening product viewing is build fast networks,and much more. [ ——

June 19th the ultimate Macintosh Webmaster event. The Product Showcase features over 100 training classes design

to get you up and goit
with the most popular
products you'll need t
plug into the World Wi
Web.

vendors, all offering solutions for Macintosh
professionals.

9:00 - 9:45

5001 Great America Parkway
Santa Clara Convention Center
Santa Clara, CA 95054

© 1997 Mactivity, inc. All rights reserved. Mactintosh is a
registered trademark of Apple Computer. All other
trademarks are registered with their respective companies.

Free Exhibits Pass
Register Online!

Your Exhibits Pass gets you access to keynotes, vendor fair,
product showcase, technology theater, hands-on classroom
and entry for the daily drawings. Register today at:

Learn how it's done!

The Mactivity Confererice is world famous for creating a fun, interactive
environment where the community of Macintosh professionals learn the
latest about Macintosh technologies. Two great conferences are offered:
The Webmasters Conference and The Mac Managers Conference. For
information or to request a FREE 16-page brochure call Mactivity at
408.354.2500 or 800.798.2928 (inside the US).

http://www.mactivity.com
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